


มารู้จักโปรแกรมMetaTrader4
สารบัญ

การดาวน์โหลดและติดตั้งโปรแกรม

1

2

3

3

3

4

4

4

7

10

10

12

12

12

13

15

15

21

23

25

26

26

27

โปรแกรม MetaTrader 4เป็นโปรแกรมที่ใช้สำ�หรับก�รซื้อข�ยสินค้�อนุพันธ์ ในตล�ด TFEX ซึ่งได้รับคว�มนิยม

สูงสุด นอกจ�กนี้ตัวโปรแกรมยังถูกพัฒน�ม�อย่�งเหม�ะสม ทำ�ให้เป็นโปรแกรมท่ีมีคว�มส�ม�รถม�กม�ยและ 

ใช้ง�นได้ง่�ยอีกด้วย

          ประโยชน์ก�รใช้ง�นโปรแกรม MetaTrader 4

                 - ใช้ง�นง่�ยและมีหน้�ต�ของโปรแกรมที่ไม่ซับซ้อน (ทำ�ให้ผู้ใช้ง�นไม่สับสน)

                 - ส�ม�รถปรับแต่งมุมมองและใส่กลุ่มสีสำ�หรับกร�ฟต่�งๆ ได้อย่�งอิสระ

                    - ส�ม�รถเลือกก�รแสดงผลกร�ฟได้ถึง 3 ประเภทหลักคือ Bar Chart, Candlesticks และLine Chart

                 - เลือกแสดงผลกร�ฟได้ 9 ช่วงเวล�(Timeframe)

                 - รองรับอินดิเคเตอร์ (Indicator) ที่ม�พร้อมกับโปรแกรมจำ�นวนม�กกว่� 50 รูปแบบ

                   (ช่วยให้นักลงทุนวิเคร�ะห์ทิศท�ง ร�ค�ได้ง่�ยขึ้น)

                 - ส�ม�รถเพิ่มอินดิเคเตอร์หล�ยชนิดได้ในกร�ฟเดียวกัน

                 - ส�ม�รถแสดงผลร�ค�ได้หล�ยคู่พร้อมกัน

                 - รองรับโปรแกรมเทรดแบบอัตโนมัติEA (Expert Advisor)

- สำ�หรับ Windows

1. ด�วน์โหลดตัวติดตั้งโปรแกรมได้ที่ http://www.toptrader.co.th/download/

2. ตัวอย่�งติดตั้งโปรแกรม ต�มlinkนี้:http://goo.gl/hjG1Za
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การติดตั้งและรัน Expert Advisor (EA)
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การดาวน์โหลดและติดตั้งโปรแกรม 

    - สำ�หรับ Windows 

การเข้าใช้งานโปรแกรม MetaTrader 4 

     ก�ร Log in 

     ก�รเปลี่ยนรหัสผ่�น 

การเปิดกราฟ 

Toolbar 

    1. Standard bar 

    2. Chart bar 

    3. Line studies bar 

    4. Periodicity bar 

การเพิ่ม Indicator 

การใช้คำาสั่งซื้อ-ขายในโปรแกรมMetaTrader 4 

    ก�รเปิด/ปิดออเดอร์ 

คีย์ลัดในโปรแกรม MetaTrader 4 

การติดตั้งและรัน Expert Advisor (EA) 

การทดสอบระบบ (BackTest) 

Email & Notifications 

    E-mail 

    Notifications 



การเปลี่ยนรหัสผ่าน

การ Login
1. วิธีก�ร login เข้�สู่ระบบให้คุณไปที่ เมนู File แล้วเลือก Login กรอกชื่อบัญชีผู้ใช้ออนไลน์และรหัสผ่�น  

    ส่วน Server ให้เลือกเป็นTopTrader Co-Liveจ�กนั้นกด Login เพื่อเข้�สู่ระบบ

1. เข้�ไปที่เมนู Tools -> Options

2. คลิกที่แท็บServer และกดปุ่ม Change

3. ที่ช่อง Current password ให้ใส่รหัส

ผ่�นปัจจุบัน, ช่อง New password ใส่

รหัสผ่�นที่ต้องก�รเปลี่ยน (รหัสผ่�นจะ

ต้องมีคว�มย�วอย่�งน้อย 5 ตัว และ 2 

ใน 3 จะต้องมีตัวอักษรตัวเล็ก, ตัวใหญ่, 

และตัวเลขรวมอยู่ด้วย), ช่อง Confirm 

ใส่รหัสผ่�นใหม่ยืนยันอีกครั้ง เสร็จแล้ว

กด OK

2. ถ ้� Log in ผ ่�นเร ียบร ้อยแล ้ว ตรงม ุมล ่�งขว�

จะแสดงเครื่องหม�ยดังรูป ถ้� Log in ไม่ผ่�นจะแสดงคำ�ว่�  

No Connection หรือ Invalid Account หรือข้อคว�ม Error 

อื่นๆ
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เมื่อเข้�สู่ระบบแล้ว คุณส�ม�รถเพิ่ม

กร�ฟที่คุณต้องก�รได้โดย ไปที่เมนู 

File แล้วเลือก New Chart จ�กนั้น

เลือกสินค้�ที่คุณต้องก�รได้

การเข้าใช้งานโปรแกรม MetaTrader 4
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ต่อจ�กนั้นเร�จะม�ศึกษ�ร�ยละเอียดภ�ยในโปรแกรมและวิธีก�รเทรดกัน ซึ่งตัวโปรแกรมส�ม�รถแบ่งได้เป็น  

5 ส่วนหลักๆต�มรูป

1.กดเคร่ืองหม�ยบวกท่ีอยู่ด้�นบนซ้�ยและ

เลือกสินค้�ที่ต้องก�รถ้�ไม่เจอสินค้�ที่ต้องก�ร 

ให้เข้�ไปคลิกขว�ที่หน้�ต่�ง Market Watch 

และเลือกที่ Show All

การเปิดกราฟ

ส่วนที่ 1 จะเป็น Menu Bar และ Tool Bar มีเครื่องมือสำ�หรับก�รวิเคร�ะห์กร�ฟ

ส่วนที่ 2 Market watch แสดงร�ยละเอียดของสินค้�ต่�งๆ

ส่วนที่ 3 Navigator เป็นส่วนที่แสดง ชื่อและเลขบัญชีก�รลงทุนของเร�

                   - Account คือเลขบัญชีออนไลน์ของคุณและชื่อของคุณ

                   - Indicator คือเครื่องมือช่วยในก�รวิเคร�ะห์ ที่ม�กับระบบของโปรแกรม MT4

                   - Custom Indicator คือร�ยก�ร indicator ที่add เข้�ม�เพิ่มนอกเหนือจ�กที่ระบบมีไว้ให้แล้ว

       ห�กเร�ต้องก�รเพิ่ม indicator ใน MT4 ให้ copy ไฟล์ไปว�งที่ 

                     C:\Program Files\MetaTrader4 – TopTrader\MQL4\Indicators

                   - Expert Advisors (EA) คือโปรแกรมที่ทำ�ร�ยก�รซื้อข�ยให้อัตโนมัติ ห�กเร�ต้องก�รเพิ่ม

                     Expert Advisor ใน MT4 ให้ copy ไฟล์ไปว�งที่ 

                     C:\Program Files\MetaTrader4 - Top Trader\MQL4\Experts

ส่วนที่ 4 คือกร�ฟสินค้�ที่คุณทำ�ก�รเปิดขึ้นม�

ส่วนที่ 5 เป็นร�ยละเอียดเกี่ยวกับก�รซื้อข�ยสินค้�ของคุณและเงินทุนของคุณ



2. กร�ฟของสินค้�จะแสดงขึ้นม�ดังรูป เวล�ในกร�ฟจะเป็นเวล�ที่ Server ของตล�ดนั้นๆ 4.ที่แท็บColors ส�ม�รถเปลี่ยนสีของกร�ฟได้

5.ที่แท็บCommon ส�ม�รถเปลี่ยนรูปแบบของกร�ฟรวมถึงให้แสดงหรือซ่อนเส้นต่�งๆได้

3. ส�ม�รถปรับแต่งรูปแบบของกร�ฟ เช่น สี, ประเภทของกร�ฟ, เส้นต่�งๆ โดยคลิกขว�ที่กร�ฟและเลือก  

     Properties หรือกด F8
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Toolbar
ที่ Toolbar ก็จะมีไอคอนต่�งๆให้ใช้ง�นดังนี้ (เรียงลำ�ดับต�มกรอบสีแดงที่วงไว้จ�กบนลงล่�ง) 1.4 Data Window - หน้�ต่�งดูข้อมูลร�ค�เปิด, 

ปิด, สูงสุด, ต่ำ�สุด, Volume ของกร�ฟ ให้นำ�

เม�ส์ไปว�งไว้ท่ีตำ�แหน่งท่ีต้องก�รดูร�ยละเอียดใน

กร�ฟ

1.5 Navigator - หน้�ต่�งแสดงร�ยชื่อ, 

Indicator, EA, Script

1.6 Terminal - หน้�ต่�งแสดงออเดอร์ที่กำ�ลังเปิดอยู่, ประวัติก�รเทรด, 

Mailbox, Log ของ EA, ร�ยละเอียดก�ร Log in รวมถึง Error ต่�งๆ

1.Standardbar
1.1 New chart – ก�รเปิดหน้�ต่�งกร�ฟใหม่

1.2 Profile –หน้�ต่�งสินค้�ที่เร�กำ�หนดไว้

1.3 Market Watch – หน้�ต่�งดูร�ค�ของสินค้�ต่�งๆแบบเรียลไทม์
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1.7 Strategy Tester - หน้�ต่�งไว้สำ�หรับก�รเทสEA(ร�ยละเอียดอยู่ในเรื่องก�รทดสอบระบบ)

1.8  ปุ่มเปิดออเดอร์ซื้อข�ย

1.9  ปุ่มเปิด MetaEditor (ใช้เขียน EA) 

1.10 ปุ่มเปิด/ปิดก�รใช้ง�น EA (ถ้�ก�รเปิดใช้ง�นปุ่มจะเป็นสีเขียว ถ้�ปิดก�รใช้ง�นปุ่มจะเป็นสีแดง)

1. คลิกที่ปุ่ม Indicators ท�งด้�นบนและเลือก Indicator ที่ต้องก�รเพิ่ม

2. เสร็จแล้วจะมีหน้�ต่�งเพื่อเซตค่�ต่�งๆสำ�หรับ Indicator ตัวอย่�งแสดงก�รเพิ่ม Moving Average

2. Chartbar
2.1 ปุ่มแสดงรูปแบบกร�ฟเป็นแบบแท่ง

2.2 ปุ่มแสดงรูปแบบกร�ฟเป็นแบบแท่งเทียน

2.3 ปุ่มแสดงรูปแบบกร�ฟเป็นแบบเส้น

2.4 ปุ่มขย�ยกร�ฟ

2.5 ปุ่มย่อกร�ฟ

2.6 ปุ่ม Auto Scroll ให้กร�ฟขยับไปท�งซ้�ยเรื่อยๆเมื่อร�ค�มีก�รอัพเดท

2.7 ปุ่ม Chart Shift คือให้กร�ฟขยับเลื่อนไปท�งด้�นซ้�ย

2.8 ปุ่ม Indicator ไว้เพิ่ม Indicator ในกร�ฟ

2.9 ปุ่ม Period ไว้เลือกช่วงเวล� (Timeframe) ต่�งๆ

2.10 ปุ่ม Templates ไว้เซฟรูปแบบกร�ฟเก็บไว้

3. Linestudiesbar
3.1 ปุ่มเลือกรูปแบบเม�ส์เป็น Cursor เพื่อแสดงในกร�ฟ

3.2 ปุ่มเลือกรูปแบบเม�ส์เป็น Crosshairเพื่อแสดงในกร�ฟ

3.3 เอ�ไว้ล�กเส้น, เขียนข้อคว�มต่�งๆบนกร�ฟ, และ Indicator Fibonacci

4. Periodicitybar
4.1 เลือกช่วงเวล� (Timeframe) ต่�งๆ

การเพิ่ม Indicator
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3. Indicatorก็จะแสดงในกร�ฟดังรูป

4. ถ้�ต้องก�รแก้ค่�ต่�งๆของ Indicator ให้ดับเบิ้ลคลิกที่ Indicator ก็จะมีหน้�ต่�งเซตค่�ต่�งๆแสดงขึ้นม�  

     เหมือนในข้อที่ 2

5. ถ้�ต้องก�รลบ ให้กด (Ctrl + i) จะแสดงร�ยชื่อ Indicator ทั้งหมดที่อยู่ในกร�ฟ ให้คลิกชื่อ Indicator 

    ที่ต้องก�รลบ แล้วกด Delete

1. หลังจ�กคุณได้ทำ�คว�มรู้จักกับโปรแกรม MetaTrader 4 แล้ว ห�กคุณต้องก�รซื้อข�ยให้คุณกด F9 หรือ 

    คลิกขว�ที่กร�ฟ> Trading > New Order จะปร�กฏBox แสดงร�ยละเอียดเกี่ยวกับก�รซื้อข�ยขึ้นม�

2. จะมีหน้�ต่�งแสดงขึ้นม�ดังรูป

การเปิด/ปิดออเดอร์

2.1 Symbol –สินค้�ที่ต้องก�รซื้อข�ย

2.2 Volume - จำ�นวนสัญญ�ที่ต้องก�รเทรด

2.3 Stop Loss - ร�ค�ที่จะให้ปิดออเดอร์อัตโนมัติเมื่อข�ดทุน

2.4 Take Profit - ร�ค�ที่จะให้ปิดออเดอร์อัตโนมัติเมื่อกำ�ไร

2.5 Comment - ส�ม�รถใส่ Comment สำ�หรับออเดอร์ที่จะเปิด

2.6 Type - Instant Execution / Market Execution*คือเปิดออเดอร์ทันที, Pending Order 

      คือเปิดออเดอร์  แบบ Pending (รอให้ร�ค�ม�ถึงจุดที่เร�ต้องก�รถึงจะทำ�ก�รเปิดออเดอร์) 

      *หม�ยเหตุถ้�ใน Server Live จะเป็น Market Execution

2.7 Sell - เปิดออเดอร์ข�ย

2.8 Buy - เปิดออเดอร์ซื้อ

การใช้คำ สั่งซื้อ-ขายในโปรแกรมMetaTrader 4

6. ส�ม�รถลง Indicator อื่นๆเพิ่มเติมได้โดยให้เข้�ไปที่เมนู File -> Open data folder แล้วนำ�ไฟล์ Indicator    

    (ไฟล์น�มสกุล mq4 หรือ ex4) ใส่ไว้ที่โฟลเดอร์

    C:\Program Files\MetaTrader 4 - Top Trader\MQL4\Indicators

    เสร็จแล้ว Restart MT4, ทำ�ต�มข้อ 1 ก็จะเห็นชื่อ Indicator ที่เพิ่มไว้อยู่ในหัวข้อ Custom



3. ถ้�เลือกก�รเปิดออเดอร์เป็นแบบ Pending หน้�ต่�งจะเปลี่ยนเป็นดังรูป ก�รเปิดออเดอร์แบบนั้เป็นก�รตั้งเปิด

ออเดอร์ทิ้งไว้ในกรณีที่ร�ค�ที่เร�ต้องก�รซื้อหรือข�ยยังไม่เกิดขึ้น เมื่อร�ค�ปัจจุบันม�ถึงร�ค�ที่เร�ตั้งไว้ 

ออเดอร์ก็จะเปิดให้อัตโนมัติ
3.1.2 Sell Limit คือทำ�ก�รข�ยเมื่อร�ค�ปัจจุบันอยู่ต่ำ�กว่�ร�ค�ที่เร�จะข�ย

3.1.3 Buy Stop คือทำ�ก�รซื้อเมื่อร�ค�ปัจจุบันอยู่ต่ำ�กว่�ร�ค�ที่เร�จะซื้อ

ในส่วน Pending Order จะมีค่�ต่�งๆให้เลือกดังนี้

3.1 Type order 

ตัวอย่าง
3.1.1Buy Limit คือทำ�ก�รซื้อเมื่อร�ค�ปัจจุบันอยู่สูงกว่�ร�ค�ที่เร�จะซื้อ
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3.1.4 Sell Stop คือทำ�ก�รข�ยเมื่อร�ค�ปัจจุบันอยู่สูงกว่�ร�ค�ที่เร�จะข�ย

3.2 at price - ใส่ร�ค�ที่เร�ต้องก�รซื้อข�ย

3.3 Place - ทำ�ก�รเปิดออเดอร์Pending

3.4 Expiry –เวล�หมดอ�ยุของออเดอร์แต่ละออเดอร์ ถ้�เลยเวล�ที่ระบุออเดอร์นั้นๆจะถูกยกเลิกโดยอัตโนมัติ

5. ถ้�ต้องก�รปิดออเดอร์ ให้ดับเบิ้ลคลิกที่ร�ยละเอียดของออเดอร์ จะมีหน้�ต่�งแสดงขึ้นม�ดังรูป เลือก Type 

เป็น Instant Execution และกดปุ่ม Close เพื่อปิดออเดอร์

4. ถ้�ทำ�ก�รเปิดออเดอร์แล้วจะเห็นร�ยละเอียดออเดอร์ที่หน้�ต่�ง Terminal ด้�นล่�งดังรูป

4.1   Order - หม�ยเลขออเดอร์

4.2   Time - เวล�ที่ทำ�ก�รเปิดออเดอร์ (เวล�ใน Server)

4.3   Type - ประเภทออเดอร์ (ซื้อหรือข�ย)

4.4   Size –จำ�นวนสัญญ�

4.5   Symbol –สินค้�

4.6   Price - ร�ค�ที่ทำ�ก�รเปิดออเดอร์

4.7   S/L - ร�ค� Stop Loss (หม�ยเหตุ 0 คือไม่ได้ทำ�ก�รเซต)

4.8   T/P - ร�ค� Target Profit (หม�ยเหตุ 0 คือไม่ได้ทำ�ก�รเซต)

4.9   Price - ร�ค�ปัจจุบัน

4.10 Commission - ค่�คอมมิชชั่น

4.11 Profit - กำ�ไร/ข�ดทุน

4.12 Balance - ยอดเงินที่ยังไม่รวมกำ�ไรหรือข�ดทุนของออเดอร์ที่กำ�ลังเปิด

4.13 Equity - ยอดเงินที่รวมกำ�ไรหรือข�ดทุนของออเดอร์ทั้งหมดที่กำ�ลังเปิดอยู่

4.14 Margin - จำ�นวน Margin ทั้งหมดที่ใช้ไปในก�รเปิดออเดอร์

4.15  Free Margin - จำ�นวน Margin ที่เหลือเพื่อไว้สำ�หรับเปิดออเดอร์

4.16 Margin Level - มีค่�เท่�กับ (Volume*intial_margin/100) ถ้�ลดเหลือน้อยต่ำ�กว่�ค่� Margin level 

ตรงออเดอร์จะเป็นสีแดงๆเตือนขึ้นม� ถ้�ต่ำ�กว่� Stop level ออเดอร์ก็จะถูกปิดให้โดยอัตโนมัติ ซึ่งแต่ละบัญช ี

ก็จะมีระดับ Margin level และ Stop Level ที่แตกต่�งกัน

6. ถ้�ต้องก�รแก้ไขออเดอร์ เช่น Stop Loss หรือ Take Profit ให้ดับเบิ้ลคลิกที่ร�ยละเอียดของออเดอร์ จะม ี

หน้�ต่�งแสดงขึ้นม�ดังรูป เลือก Type เป็น Modify Order แก้ไขร�ยละเอียดด�มต้องก�ร และกดปุ่ม Modify 

เพื่อแก้ไขออเดอร์

Tips: ก�รใช้ง�น One click Trading ส�ม�รติดต�มได้ต�มลิงค์นี้ http://goo.gl/86SoiD
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7. ถ้�ทำ�ก�รปิดออเดอร์แล้ว ร�ยละเอียดออเดอร์ก็จะย้�ยไปอยู่ในแท็บ Account History ดังรูป

8. ที่แท็บAccount History ส�ม�รถคลิกขว�เพื่อเลือกออฟชั่นต่�งๆได้ดังนี้

9.  ที่แท็บJournal จะแสดงร�ยละเอียดคำ�สั่งที่เร�ทำ�ก�รเทรดทั้งหมด รวมถึง Error ต่�งๆ

8.1  All History - ให้แสดงประวัติก�รเทรดทั้งหมด 

      (โดย Default จะแสดงประวัติก�รเทรดของเดือนปัจจุบัน)

8.2  Last 3 Months - ให้แสดงประวัติก�รเทรดย้อนหลัง 3 เดือน

8.3  Last Month - ให้แสดงประวัติก�รเทรดของเดือน  ปัจจุบัน

8.4 Custom Period - ส�ม�รถเลือกช่วงเวล�ที่จะให้แสดง   

       ประวัติก�รเทรดได้

8.5 Save as Report - คือก�ร Export ประวัติก�รเทรด 

       ออกม�เป็นไฟล์

8.6  Save as Detailed Report - คือก�ร Export  

       ประวัติก�รเทรดแบบละเอียดออกม�เป็นไฟล์

8.7  Commissions - ให้แสดง/ซ่อนคอลัมน์ Commissions

8.8  Taxes - ให้แสดง/ซ่อนคอลัมน์ taxes

8.9  Comments - ให้แสดง/ซ่อนคอลัมน์ Comments

8.10  Auto Arrange - จัดขน�ดของคอลัมน์อัตโนมัติ

8.11  Grid - ให้แสดง/ซ่อนเส้นแบ่งคอลัมน์

7.1  Order - หม�ยเลขออเดอร์

7.2  Time - เวล�ที่ทำ�ก�รเปิดออเดอร์ (เวล�ใน Server)

7.3  Type - ประเภทออเดอร์ (ซื้อหรือข�ย)

7.4  Size - จำ�นวนสัญญ�

7.5  Symbol –สินค้�

7.6  Price - ร�ค�ที่ทำ�ก�รเปิดออเดอร์

7.7  S/L - ร�ค� Stop Loss 

       (หม�ยเหตุ 0 คือไม่ได้ทำ�ก�รเซต)

7.8  T/P - ร�ค� Target Profit 

       (หม�ยเหตุ 0 คือไม่ได้ทำ�ก�รเซต)

7.9  Time - เวล�ที่ทำ�ก�รปิดออเดอร์ 

       (เวล�ใน Server)

7.10  Price - ร�ค�ที่ทำ�ก�รปิดออเดอร์

7.11  Commission - ค่�คอมมิชชั่น

7.12  Profit - กำ�ไร/ข�ดทุน

ลูกศรซ้�ย = เลื่อนกร�ฟไปท�งซ้�ย

ลูกศรขว� = เลื่อนกร�ฟไปท�งขว�

Page Up = เลื่อนกร�ฟไปท�งซ้�ยแบบรวดเร็ว

Page Down = เลื่อนกร�ฟไปท�งขว�แบบรวดเร็ว

Home = เลื่อนกร�ฟกลับไปในอดีตที่โปรแกรมส�ม�รถแสดงให้ดูได้

End = เลื่อนกร�ฟกลับม�ที่ปัจจุบัน

ปุ่มลบ (-)=ซูมกร�ฟอออก

ปุ่มบวก (+) =ซูมกร�ฟเข้�

Delete = ลบเครื่องมืดที่ขีดไว้ออกจ�กหน้�จอ

ปุ่ม Backspace = ลบเครื่องมือที่ล�กไว้ล่�สุดออกไป

ปุ่ม Enter = เปิดหน้�ต่�งค้นห�กร�ฟ

ปุ่ม ESC = ปิดหน้�ต่�งค้นห�กร�ฟ

ปุ่มฟังชั่นต่�งๆ (Function Keys)

F1 = เปิดคู่มือก�รใช้ง�น MT4 เบื้องต้น (ภ�ษ�อังกฤษ)

F2 = เปิดดูข้อมูลของกร�ฟย้อนหลัง

F4 = เปิด “Meta editor” (แก้ไขข้อมูลของโปรแกรมใน drive c)

F8 = เปิดหน้�ต่�ง “Properties” ขึ้นม�

F9 = เปิดหน้�ต่�ง New Order

F10 = เปิดหน้�ต่�ง Popup Price (จะเป็นตัวเลขเล็กๆวิ่งไปวิ่งม�) ขึ้นม�

F11 = ทำ�ใจกร�ฟกล�ยเป็น Full Screen (ขย�ยเต็มจอ)

F12 = เลื่อนหน้�จอกลับไปท�งซ้�ย

ปุ่ม Shift + ปุ่มฟังชั่น 

Shift + F12 = ปุ่มเลื่อนร�ค�ย้อนกลับทีละหนึ่งแท่งเทียน

Shift + F5 = เปลี่ยนกร�ฟที่เรียงอยู่ส่วนของ profile ของเร�

ปุ่ม Alt + ปุ่มลัด

Alt + 1 = เปลี่ยนรูปแบบของกร�ฟเป็นรูปแบบของ Bar Chart

Alt + 2 = เปลี่ยนรูปแบบของกร�ฟเป็นรูปแบบ Candlestick Chart

Alt + 3 = เปลี่ยนรูปแบบของกร�ฟเป็นรูปแบบ Line Chart (กร�ฟเส้น)

Alt + W = เรียกหน้�ต่�งช่วยในก�รจัดก�รกร�ฟปัจจุบันที่ใช้อยู่ออกม�
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การติดตั้งและรัน Expert Advisor (EA)

1. ให้เข้�ไปที่เมนู File -> Open data folder แล้วใส่ไฟล์ EA ที่โฟลเดอร์ 

C:\Program Files\MetaTrader 4 - Top Trader\MQL4\Experts

ส่วนไฟล์ Indicator ใส่ไว้ที่โฟลเดอร์ C:\Program Files\MetaTrader 4 - Top Trader\MQL4\Indicators

2.  คลิกปุ่ม Expert Advisors ใน Toolbar ให้เป็นสีเขียวดังรูป

3. จะเห็นชื ่อ EA ที ่ห ัวข้อ Expert Advisors  

ในหน้�ต่�ง Navigator ดังรูป ให้คลิกที่ชื่อ EA แล้ว

ล�กใส่ในกร�ฟ

4. จะมีหน้�ต่�งแสดงขึ้นม�เพื่อตั้งค่�ดังรูป

Alt + F4 = ปุ่มออกจ�กโปรแกรม

Alt + Backspace = เรียกเอ�เครื่องมือที่ลบไปล่�สุดกลับคืน

ปุ่ม Ctrl + ปุ่มลัด

Ctrl + A = ปรับขน�ดของหน้�จออินดิเคเตอร์ให้กลับม�อยู่ในรูปร่�งปกติ (ในกรณีที่มีอินดิเคเตอร์ในหน้�จอ)

Ctrl + B = เรียกหน้�ต่�ง “จัดก�รเครื่องมือ (Object List)”ขึ้นม�

Ctrl + C = ก๊อบบี้ตัวอักษร หรือ คำ�ใน MT4

Ctrl + D = เรียกหน้�ต่�ง Data Window ออกม�

Ctrl + E = เรียกใช้ Expert Advisor (EA)

Ctrl + F = เรียกใช้เครื่องมือ “Cross Hair”

Ctrl + G = เรียกใช้หรือไม่ใช้ Grid (ต�ร�ง)

Ctrl + H = เรียกดู OHLC ( Open, High, Low, Close) ของวัน

Ctrl + I = เรียกหน้�ต่�ง “จัดก�รอินดิเคเตอร์(Indicator List)” ขึ้นม�

Ctrl + L = เรียก Volume ของร�ค�ให้ขึ้นม�แสดงผลบนหน้�จอ

Ctrl + M = เรียกหน้�ต่�ง Market Watch ออกม�

Ctrl + N = เรียกหน้�ต่�ง Navigator ออกม�

Ctrl + O = เรียกหน้�ต่�ง Option หรือ Setup ออกม� 

Ctrl + P = ปรินท์กร�ฟออกม� (ในกรณีที่ต้องก�รปรินท์กร�ฟออกม�ดูข้�งนอก)

Ctrl + R = เรียกหน้�ต่�ง Tester ออกม�

Ctrl + S = เซฟกร�ฟที่ใช้เทรดเอ�ไว้ซึ่งจะออกม�ในรูปแบบของไฟล์น�มสกุล “CSV”, “PRN”, “HTM”;

Ctrl + T = เรียกหน้�ต่�ง Terminal ออกม�

Ctrl + W หรือ Ctrl + F4 = ปิดหน้�ต่�งกร�ฟที่ใช้อยู่ในปัจจุบัน

Ctrl + Y = แสดงหรือซ่อนเส้นแบ่งวัน Period Separator)

Ctrl + Z = เรียกเอ�เครื่องมือที่ลบไปล่�สุดกลับคืน

Ctrl + ปุ่มฟังชั่น

Ctrl + F5 = เปลี่ยนกร�ฟที่ได้ตั้งค่�ไว้ใน profile ของเร�

Ctrl + F6 = เปลี่ยนหน้�ต่�งของกร�ฟที่เร�ใช้อยู่ ณ ปัจจุบันเป็นอันถัดไป



4.1   Only Long - ให้ EA เปิดออเดอร์ซื้อเท่�นั้น

4.2   Only Short - ให้ EA เปิดออเดอร์ข�ยเท่�นั้น

4.3   Long & Short - ให้ EA เปิดออเดอร์ทั้งซื้อและข�ย

4.4   Enable alerts - เปิด/ปิดก�รแจ้งเตือน

4.5   Disable alert once hit - ปิดก�รแจ้งเตือนเมื่อมีก�รแจ้งเตือนครั้งแรกม�แล้ว

4.6   Allow live trading - ให้ EA เปิดออเดอร์ในบัญชีเทรดจริงได้หรือไม่

4.7   Ask manual confirmation - ถ้� EA ต้องก�รเปิดออเดอร์ ให้เร�ต้องทำ�ก�รยืนยันอีกหรือไม่

4.8   Allow DLL imports - อนุญ�ตให้ EA มีก�รเรียกใช้ DLL หรือไม่

4.9   Confirm DLL function calls - ให้มีก�รยืนยันทุกครั้งเมื่อมีก�รเรียกใช้ฟังก์ชั่นใน DLL หรือไม่

4.10 Allow import of external experts - อนุญ�ตให้มีก�รเรียกใช้ฟังก์ชั่นใน EA ตัวอื่นหรือไม่

หม�ยเหตุ โดยทั่วไปจะติ๊กที่ช่อง Long & Short ,Enable alerts ,Allow live trading ,Allow DLL imports 

,Allow import of external experts

5. ที่แท็บInputs ก็จะเป็นก�รเซตค่�พ�ร�มิเตอร์ต่�งๆที่ใช้ใน EA ซึ่ง EA แต่ละตัวก็จะมีก�รตั้งค่�ที่แตกต่�งกัน

Expert Advisor - ให้เลือกร�ยชื่อ EA ที่จะทำ�ก�รทดสอบ

Symbol - ให้เลือกสินค้�ที่จะทำ�ก�รทดสอบ

Period - ระยะเวล�ของกร�ฟ

Model - รูปแบบที่ใช้ทดสอบ

Use date - ใช้เลือกช่องเวล�ในก�รทดสอบ

Visual mode - ใช้แสดงก�รทำ�ง�นในรูปแบบกร�ฟฟิกคือโปรแกรมจะว�ดกร�ฟแสดงในช่วงเวล�ที่ทำ�ก�ร

ทดสอบเลย

Expert properties - ใช้ปรับแต่งรูปแบบก�รทดสอบ ส�ม�รถปรับเปลี่ยนจำ�นวนเงินและหน่วยของเงินที่ใช้

ทดสอบรูปแบบก�รเปิด

ออเดอร์ และใช้ปรับเปลี่ยนค่�ของ EA ที่ส�ม�รถกำ�หนดค่�เริ่มต้นได้

หม�ยเหต ุที่หน่วยค่�เงินให้เปลี่ยนเป็น THB โดยส�ม�รถพิมพ์ได้เลย

6. ถ้�ติดตั้งเสร็จเรียบร้อยก็จะแสดงชื่อ EA และรูปหน้�ยิ้มอยู่ด้�นบนขว�มือของกร�ฟดังรูป
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การทดสอบระบบ (BackTest)

Symbol properties - จะแสดงข้อมูลของสินค้�ที่เร�เลือกให้ทดสอบ

Open chart - ให้แสดงกร�ฟ

Modify expert - จะเอ�ไว้เปิด Code EA เพื่อทำ�ก�รแก้ไข

Start - ใช้เริ่มทำ�ก�รทดสอบ

หม�ยเหต ุวันที่ในเครื่องคอมพิวเตอร์ ต้องเปลี่ยนจ�กพุทธศักร�ชเป็น คริสต์ศักร�ช       
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Email&Notifications
คือก�รตั้งเตือนเมื่อมีก�รสั่งคำ�สั่งใดๆใน MT4 โดยทำ�ก�รตั้งค่�ได้ดังนี้

E-mail
1. ให้เข้�ไปที่เมนู Tools -> Options -> Email

เลือกที่ช่อง Enable

2. ตั้งค่�SMTP Server  เช่นGmailใช้ smtp.gmail.com:465เป็นต้น

SMTP login - ชื่อ Email

SMTP password – รหัสผ่�นที่ใช้ใน Email

From – ชื่อผู้ส่ง

To – ชื่อผู้รับ

3. กด OK เพื่อเริ่มก�รใช้ง�น

Notifications
ก�รตั้งเตือนผ่�น Smart phone หรือ Tablet โดยผ่�น Application MT4 

โดยขั้นตอนดังต่อไปนี้ (Android, IOS)

1. ให้เข้�ไปที่เมนู Tools -> Options ->Notifications
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เลือกที่ช่อง Enable

ท�งฝั่ง Smart phone หรือ Tablet (Android ,iOS)
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นำ�ค่� MY ID ไปใส่ในช่อง MetaQuotes ID ของโปรแกรม MT4 (PC)
เมื่อมีก�รส่งคำ�สั่งจะแสดงบน Smart phone หรือ Tablet(Android ,iOS) จะแสดงภ�พดังนี้





ช่ือหนงัสือ   คู่มือการใชง้าน MetaTrader4 

ช่ือผูแ้ต่ง/รวบรวม   ทอ๊ปเทรดเดอร์ 

ฉบบัพิมพท่ี์ 1       พิมพค์ร้ังแรก   สิงหาคม 2557                            

สงวนสิทธ์ิตามประราชบญัญติัลิขสิทธ์ิ 
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จดัท ารูปเล่ม จดัพมิพ ์ 

บริษทั   ทอ๊ปเทรดเดอร์ 
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